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Abstract

Heart rate variability (HRV) is commonly used to assess the function of the autonomic nervous
system, which is linked to diseases such as cardiovascular disease, diabetes, hypertension, respiratory
diseases, and stress. Many studies of the relationship between these diseases and HRV indices have been
reported. Generally, the computation of HRV indices is relatively complicated. Moreover, recent
researches regarding HRV have employed increasing numbers of electrocardiogram records. Thus, the
computation and data processing required are even more complex. Therefore, we propose computer
programs for visualizing and analyzing HRV. The proposed programs are developed under MATLAB
GUIDE and are available as open source software tools for researchers to develop or modify. We evaluate
the programs with MIT-BIH database. The results show that the proposed software tools facilitates the
computation of HRV in batch processing mode and the visualization of all of the details, as well as the
properties and trends, of HRV indices over long successive epochs. Especially, the software allows us to
divide signals into groups for comparing HRV indices. Therefore, the tools are useful for researchers who
deal with large cohort ECG signals.
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Introduction

The autonomic nervous system (ANS)is a control system that acts largely unconsciously and
regulates bodily functions such as the heart rate, digestion, respiratory rate, body temperature, pupillary
response, urination, and sexual arousal. ANS is composed of the parasympathetic nervous system (PNS)
and the sympathetic nervous system (SNS). It is known that ANS function is related to several cardiac
diseases; for example, coronary heart disease, sudden cardiac death, cardiac arrhythmia, heart failure,
diabetes, and hypertension [1,2]. Heart rate variability (HRV), the variability of intervals between
consecutive heartbeats, is a commonly-used tool for assessing the functional ability of ANS. Increased
SNS or decreased PNS activity results in increasing heart rate and decreasing HRV. On the other hand,
decreased SNS activity or increased PNS activity causes low heart rate but high HRV. As a result, the
degree of variability in heart rate provides information about the functioning of the nervous control over
heart rate and the heart's ability to respond [3]. Many studies have reported that HRV is related to some
cardiac diseases. For example, decreased HRV during daytime is related to increased cardiovascular risk,
such as stroke [4]. Beat to beat variability during deep breathing decreases in diabetic patients before
clinical symptoms become evident [3]. It was reported that HRV decreases with recent myocardial
infarction [5]. HRV increases after resistance training in individuals with chronic obstructive pulmonary
disease [6]. Therefore, HRV is a reliable tool that reflects physiological factors modulating the normal
rhythm of the heart.

HRYV can be quantified using multiple methods, each reflecting different characteristics of heart
rate. Generally, the HRV computation methods proposed in the literature can be divided into 4 main
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methods based on domains of signal processing technique used to compute HRV, which are: time
domain, frequency domain, time-frequency domain, and nonlinear method. Computer programming has
been used to assist in calculating HRV, since it requires computational and signal processing skills.
Usually, the calculation starts from pre-processing the ECG signal, detecting R peaks, and computing the
RR interval. The RR interval signal is then used as the input for HRV computation. Several computer
programs have been proposed to facilitate HRV analysis, both for commercial and non-commercial use.
Some examples are POLYAN [7], ECGLab [8], RHRV [9], a program designed for computing HRV, T-
wave alternant, and heart rate turbulence [10], Kardia [11], Kubios [12], and HRVanalysis [13]. ECGLab
is a MATLAB toolbox that performs R peak detection and HRV analysis from raw ECG recordings.
POLYAN is another MATLAB-based software designed for analyzing several simultaneous signals
stored in a hierarchical database. Kardia can analyze multiple datasets simultaneously, calculate average
statistics across subjects, and generate analytic spreadsheets that can be used for further statistical
analysis. RHRYV is designed based on R language with features of statistical calculation. Kubios is a well-
designed graphical user interface with HRV calculation in time domain, frequency domain, and nonlinear
methods. Comparison between these software tools has been made [14]. In general, these software tools
are designed for different purposes, and have both strengths and weaknesses depending on user
requirements.

In this study, we propose two open source MATLAB software tools, one for computing HRV in
batch processing mode (HRVmass), and another one for viewing and comparing the results (HRViewer),
both with easy-to-use graphic user interfaces. The software HRVmass is designed to detect R peak and
compute HRV along successive epochs over the entire recording using several HRV functions. The
algorithm for detecting R peak and computing HRV can be customized. The software HRViewer has
been created for viewing details of HRV computation output and providing tools for comparing HRV
between groups of cohorts. The ECG signal and detected R peaks can also be viewed. The software
HRVmass and HRViewer have been developed using MATLAB. The source files (.m files and GUI) are
available for download and modification at
https://www.mathworks.com/matlabcentral/ fileexchange/73609-hrvmass and .../73610-hrviewer,
respectively. The purpose of our softwares is to facilitate users to see the details, an overall view, and a
statistical summary of HRV from a single epoch to multiple recording in the same window.

Computing HRV

The proposed software for computing HRV, namely, HRVmass, was designed to compute HRV in
batch processing mode. Data can be imported to HRVmass software as raw ECG or R peak files. The
Input data format panel provides radio buttons for selecting types of input files. Accepted R peak files
must be in text format and include a column of timestamps (in seconds) where R peaks occur. For the
ECG file, the software takes European Data Format (EDF), which is common for physiological data. The
EDF file comes with all important information for reconstructing the raw ECG signal, such as sampling
rate, data length, channel names, etc. Loading R peak or ECG files can be done easily by clicking on File
-> Add files menu. Then, one or more files can be selected from the file browsing window. The chosen
files are then shown in the Files panel.

R peak detection

The automated R peak detection method used in this software is based on discrete wavelet
transform, proposed previously [15]. Briefly, the algorithm attempts to find an optimal way to preprocess
the raw ECG signal and the best threshold to distinguish R peaks from other peaks. First, several discrete
wavelet reconstruction schemes are performed on the ECG signal using multiple combinations of wavelet
detail coefficients. Then, we plot the probability density function for each reconstructed signal. It is
assumed that the probability density functions of the reconstructed signals reveal mixed distributions,
each belonging to different signal sources such as baseline ripple and R peaks. The degree of overlapping
is then quantified as the “antimode”, or the amplitude of the probability density function at the local
minimum point found between two main distributions. We also compute the short-term variability of RR
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interval of the reconstructed signal. Then, we select the reconstructed signal such that its degree of
overlapping plus the short-term variability of RR interval is minimal. Finally, the threshold for separating
R peaks from the baseline and other waves of the selected reconstructed signal is its local minimum point
between two main distributions.

Time domain methods

Several HRV indices had been suggested by the Task Force of the European Society of Cardiology
and the North American Society of Pacing and Electrophysiology [16]. Time domain methods are simple
ways for computing HRV using RR interval or normal to normal (NN) interval time series. Generally,
time domain methods are calculated from the entire recording, typically 24 hour, and represent short to
long term variation in RR interval. However, in this software, we focus on sequential analysis of HRV.
Therefore, we compute HRV in 5 minutes segments which reflect only short-term variation of RR
interval. The two elementary statistical indices are the mean and standard deviation of RR interval (MNN
and SDNN, respectively). Other measures of high frequency variability are the root mean square of
successive differences of RR interval (RMSSD) and pNNS50, which is the percentage of number of
successive RR intervals differing by more than 50 milli-seconds.

In addition, there are geometric indices which are computed from a histogram of RR intervals.
Suggested bin width used to convert NN interval time series to the histogram is 1/128 seconds. Then, the
HRYV triangular index is calculated from total number of RR intervals divided by the height of the
histogram. Another geometric index is the triangular interpolation of RR interval histogram (TINN). The
calculation of TINN starts from fitting the histogram with a triangle using minimum square difference
method. Then, TINN index is measured from the base width of the triangle. Both indices express overall
HRYV and are influenced by the lower frequency component of the RR interval time series.
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Figure 1 Front view of HRVmass software.
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Frequency domain methods

Frequency domain analysis of RR intervals reveals how variance is distributed as a function of
frequency. Calculating HRV in frequency domain requires estimating of the power spectrum of RR
intervals. In this study, we employ the Lomb-Scargle method to compute periodogram (power spectral
density) of the non-uniform sampled RR interval time series in 5 minutes segments [17]. The power
spectral density is divided into very low frequency band (VLF), low frequency band (LF), and high
frequency band (HF). The frequency limits of each band for computing HRV in normal human ECG, as
suggested in [16], are: 0 - 0.04 Hz (VLF), 0.04 - 0.15 Hz (LF), and 0.15 - 0.4 Hz (HF). HRV indices
computed in this software include:

LFP: total power in LF band,
HFP: total power in HF band, and
LHR: power ratio LFP/HFP.

LFP and HFP measure variance of RR intervals in LF and HF bands, respectively. Power in LF and
HF bands can also be measured in normalized units (nu.) which represent the relative values of each
power component in proportion to the total power minus the VLFP component, where VLFP is the power
in VLF band. LFnu and HFnu are defined as:

LFnu = LFP / (Total power - VLFP) x100 %,
HFnu = HFP / (Total power - VLFP) x100 %.

With normalization, the change in total power has less effect on the values of LF and HF
components.

Nonlinear methods

Several nonlinear measures have been proposed to quantify variability in RR interval signals. In this
software, we implement Poincaré plot, approximate entropy (ApEn), sample entropy (SampEn), and
detrended fluctuation analysis (DFA).

The Poincaré plot is a scatter plot of RR;;; as a function of RR;; hence, the plot illustrates correlation
between current and the next RR interval [18]. The correlation is quantified by fitting the plot with an
ellipse aligned along the line of identity. The width of the ellipse, defined as the standard deviation of the
points perpendicular to the line of identity, represents short term variability (SD1). The length of the
ellipse, defined as the standard deviation of the points along with the line of identity, represents long term
variability (SD2). The SDratio (SD1 / SD2) is also calculated.

ApEn and SampEn are used to measure the complexity of RR intervals [19,20]. The RR interval
signal with repetitive patterns has a relatively small ApEn and SampEn. The algorithms depend on two
parameters: m, the embedding dimension (default = 2), and r, the tolerance (default = 0.2SDNN). The
source code for computing ApEn and SampEn is from the copyrighted files of Kijoon Lee [21].

DFA quantifies roughness of RR interval time series by measuring the RR fluctuation at different
window widths [22]. The degree of fluctuation is described by two parameters: a; and a, which describe
short term and long term fluctuation, respectively. The window width for a,is in the range of 4 - 16 beats,
while the window width for a, is in the range of 16 - 64 beats. The MATLAB code used in this software
is modified from the copyrighted file of Guan Wenye [23].

Additional HRV methods
Users may add code in the file name processfile.m to compute more HRV methods. Necessary
suggestion is already embedded in the file.
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Customization

It is optional to change some basic settings before processing the files using setting window, shown
in Figure 2. Here, for example, the ECG channel name, frequency of the notch filter, the segment length,
and parameters for HRV methods can be customized before processing the signal and the sequential
analyzing of HRV. By default, the output HRV index is saved in the same folder as the ECG or R time
file in .mat format. This file will be used later for viewing and comparing HRV results using the software
HRViewer, presented in the next section. However, the .txt or .xls file can also be exported if they are
selected in the setting window. If the input signal used for computing HRV is raw ECG, the R time stamp
is also saved in .txt file for viewing and analyzing. Finally, all settings can be saved for later use.
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CI Save in a new folder |C\Users\AnurakThungtong\Dropbox\Researchil| | Browse
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Figure 2 Setting window for customizing HRV parameters.

Validating HRYV indices

The HRVmass software has been validated with PhysioNet Cardiovascular Signal Toolbox [24], a
well-documented open-source software designed for validation and standardization in the clinical and
scientific community. We use 24 segments with 5 minutes length of RR interval time series of record 100,
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101, 102, and 103 from MIT-BIH arrhythmia database [25] for computing sample HRV indices. Table 1
shows average percent difference between HRV indices computed from HRVmass and PhysioNet
toolbox. The mean percent difference of each index is defined as:

N

1 X; — Y
D=1 b=y o0y

Ny

=1

where x; is the HRV index computed from RR interval segment i using HRVmass, y; is the HRV index
computed from RR interval segment i using PhysioNet toolbox, and N is the total number of segments.
Unfortunately, not all indices are included in PhysioNet; therefore, only some indices are validated.

Table 1 Mean percent difference of some HRV indices computed using HRVmass and PhysioNet
toolbox. Some indices are not compared because they do not exist in PhysioNet toolbox.

MNN SDNN RMSSD  pNNS50 TRIAN TINN
0.019 0.202 0.196 - - -

Time Domain

. LFP HFP LHR LFnu HFnu
Frequency Domain
432.948 59.30 241.805 - -
SD1 SD2 SDR ApEn SampEn  Alphal  Alpha2

Nonlinear Methods
5.029 0.409 5.328 6.902 18.597 - -

Based on the results shown in the table, the mean percent difference of time domain method is no
more than 1 percent. Frequency domain methods show relatively high percent difference. The mean
percent differences of nonlinear methods are less than 10 percent, except for sample entropy. High
percent difference is normal due to different offset and how each software deals with outlier in
preprocessing of the data. These results show that it is not suitable to compare HRV indices among
different studies, but it can still provide valid comparison within a study.

Viewing HRV

Consider a situation in which a researcher would like to view the RR interval and HRV time series
of some subjects to see how the signals change over time or change corresponding to an event under
study. To do so, the researcher starts from recording ECG signals from all subjects. Then, the researcher
computes HRV of all ECG files using the software HRVmass. The software HRVmass produces several
HRV.mat output files, each containing time series of RR intervals and HRV indices measured from the
raw ECG of each subject. For simulation purposes, we employ 4 ECG records from MIT-BIH arrhythmia
database as a sample run. The raw ECG signals in EDF format are loaded to the HRVmass software. All
settings are set to the default value. The R peak detection and HRV calculation are run in batch
processing mode.

The software HRViewer has been developed for viewing HRV using HRV.mat files, which are the
output files from the software HRVmass. The HRV.mat files are imported to the software HRViewer first
by clicking on menu Project -> New. Then, the software pops up a dialog for researcher to set the name
of the group that will be used to represent the selected HRV.mat files. Actually, the group is created for
comparison purposes, which is not necessary for this situation; hence, any name is acceptable. After
renaming the group, a file browser dialog appears for the researcher to select HRV.mat files. Once all
files are selected, the researcher then clicks Open. Now, on the HRViewer window, the group name
appears on the Groups panel, imported HRV.mat filenames appear on the Files panel, and the HRV
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indices appear on the HRV Methods panel. Figure 3 presents the front view of the software HRViewer
after all 4 files are imported. The researcher is now ready to view HRV.

To view how HRV indices of a subject change over time, the researcher first selects the group of
that subject on the Groups panel, then selects the HRV.mat file name of that subject on the Files panel,
and finally selects an HRV index on the HRV Methods panel. As a result, the selected HRV time series is
plotted on the HRV time series/Statistics panel, the statistics of the HRV measured over the recording is
presented as a box plot on the HRV Statistics panel, and the RR interval time series of the selected file is
also plotted on the RR interval (s) panel. By changing the HRV indices on the HRV methods panel, it is
simple for the researcher to search for HRV indices that correspond to the event under study. Figure 3
shows the output of the software HR Viewer when record 103 and MNN index are selected to be viewed.

In addition, the researcher may need to see details of some HRV indices. To do this, the researcher
just clicks on the RR interval plot at a time segment. Then, the histogram, power spectrum, Poincaré¢ plot,
and DFA plot of the selected segment are presented. Figure 3 shows the details of HRVs measured from
the first 5 minutes segment of the RR interval time series. Moreover, if the HRV is computed from the
raw ECG file, and the check box Show ECG on the HRViewer window is checked, the raw ECG and R -
peak detection result of the selected segment will be plotted on the ECGviewer window, as shown in
Figure 4 Changing the segment for viewing details of the HRV and ECG signal can be done on the
HRViewer window using several methods: by clicking on another segment of the RR intervals panel, or
any point on HRV time series/statistics, clicking on the arrow button on the screen, keying the number of
segment in the Segment# text box on the screen, scrolling the mouse wheel, or pressing the left / right
arrows on the keyboard. Viewing HRV and ECG in detail may give insightful information about the
recording. In addition, in the case of the researcher finding that there is something wrong with a segment,
for example, the ECG recording containing severe noises, or the R-peak detection results being invalid,
the researcher may remove this segment out of the study by clicking the button Cut on the HRViewer
window. The researcher may even remove an HRV.mat file from the group by clicking on the minus
button on the Files panel.
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Figure 3 Front view of HRViewer software showing an example of using the software to view how HRV
and RR interval time series of a subject changes over time. Details of some HRV indices of a selected RR
interval time segment are also presented.
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Figure 4 Window for viewing ECG signal and R peak detection results. The RR interval panel of the
ECGviewer window is designed as a navigation bar for selecting a segment to view the raw ECG signal
and R-peak detection results in even more detail. With both HRViewer and ECGviewer plotting together,
the researcher can view the raw ECG signal, R-peak detection results, RR interval time series, detailed
HRYV indices, HRV time series, and a box plot representing the overall statistics of the HRV time series
all at the same time.

Comparing HRV

Consider another situation in which a researcher would like to study the difference between the
HRYV of a group of patients with a heart disease and that of a healthy group. Again, the researcher starts
from recording the ECG signals from all subjects and computing HRV using the software HRVmass. The
software HRVmass produces several HRV.mat output files. These files can be divided into two groups,
one belonging to patients with heart disease, another one belonging to the healthy group. For simulation
purposes, we employ 13 ECG records from MIT-BIH arrhythmia database as a sample run. Records 100,
104, 105, 109, 112, 116, and 118 are assumed to be the first group, and records 101, 108, 113, 114, 115,
and 117 are assumed to be the second group. The HRV.mat files of the first group can be imported to the
software HRViewer by clicking on menu Project -> New. The researcher then sets the name of the first
group to be “Groupl” and starts to import the first 7 records to the program. Later, another group and its
HRV.mat files can be added to the software by clicking on the menu Group -> Add a new group, and a
dialog box appears for naming the second group. After giving a name to the second group of “Group2”,
the file browser appears for selecting HRV.mat files of the second group. The researcher then selects the
last 6 files and clicks Open; now, he is ready to compare HRV.

The comparison starts by selecting both groups on the Groups panel. Then, it can be seen in Figure
5 that the HRV time series/Statistics panel shows a boxplot of the HRV index of each selected file. The
panel HRV Statistics displays boxplots of HRV indexes measured from all selected files. Moreover,
because the selected files are from different groups, the boxplots on the HRV time series/Statistics have
different colors. This is similar to the boxplots in the HRV Statistics, in which one boxplot represents one
group. Here, the p-value of the MANOVA test of difference between two groups is provided as initial
statistical information. The box plots in HRV time series/Statistics and HRV Statistics show that the
MNN of both groups are different; hence, MNN can be used as an index for distinguishing patients with
heart disease from healthy people.
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Conclusions

In this paper, the HRVmass and HRViewer software for sequential analysis of HRV are introduced.
The HRVmass software includes time domain, frequency domain, and non-linear methods for computing
HRYV in batch processing mode. More HRV methods can be added to the software. The software supports
both RR time series and raw ECG signals in EDF format. Although the software has a built-in R peak
detection algorithm, it allows users to change the algorithm to a preferred one. In addition, several
parameters can be customized using graphical user interface. The HRViewer software shows HRV time
series, detailed HRV, such as histogram, power spectra, Poincaré plots, and DFA plots of selected
segments. The RR interval time series and ECG signals are also presented. Changing the segment to
analyze detailed HRV can be done easily. Graphical comparison of HRV between subjects or groups can
be done effectively. With user friendly interfaces, HRVmass and HRViewer allow researchers to easily
compute and visualize HRV time series (in terms of both trend and detail), as well as ECG and RR
interval time series of large cohort studies.
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Figure 5 Front view of HRViewer software showing an example of using the software to compare HRV
of heart disease and healthy groups. From this simulation, the MNN is the HRV index that differentiates
people with heart disease (Groupl) from healthy people (Group2).
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